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Definitions and Abbreviations 
Term Meaning 
3M Quarterly Assessment 
ADL Activities of Daily Living 
Adult Adults of Ages 26 - 59  
BPD Browse Partner Data 
CA-RW County Administrator, Read/Write 
Child/Youth Children of Ages 0 - 15 
CSI Client Services Information 
CSV Comma-Separated Values 
DCR Data Collection and Reporting 
DMH California Department of Mental Health 
FSP Full Service Partnership 
FY Fiscal Year 
HIPAA Health Insurance Portability and Accountability Act 
HITECH Health Information Technology for Economic and Clinical 

 IADL Instrumental Activities of Daily Living 
KET Key Event Tracking 
MH Mental Health 
MHSA Mental Health Services Act 
MHBG Mental Health Services Block Grant 
MHP Mental Health Plan 
MHSIP Mental Health Statistics Improvement Program 
Older Adult Older Adults of Ages 60+ 
PAF Partnership Assessment Form 
PHI Protected Health Information 
PLD Partner-Level Data 
Partner A Client of the Full Service Partnership 
RO Read Only 
RPR Run Partner Report 
RW Read/Write 
SB Security Breach 
SED Seriously Emotionally Disturbed 
SSA State System Administrator 
TAY Transitional Age Youth (Ages 16 – 25) 
TOC Table of Contents 
WIC California Welfare and Institution Code 
XML Extensible Markup Language 

             
XSD XML Schema Definition 
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Chapter 1:  Introduction 
The Partner-Level Data (PLD) Templates are designed to provide a comprehensive summary of a 
partner’s Full Service Partnership (FSP) Data Collection and Reporting System (DCR) partnership 
data for the purposes of data quality. The PLD Templates display and organize domain data for 
the partnership’s current status and history in the last 12 months before joining the FSP. 
(Information on the time prior to the last 12 months before joining the FSP is not included in 
these templates.) All administrative changes, such as program or coordinator changes, are also 
displayed within PLD Templates. 

Scope 
PLD Templates are provided empty of data and are designed to work with the FSP DCR comma-
separated values (CSV) files which can be downloaded from the online FSP DCR application.  

Note:   The FSP DCR currently only allows users with a role of County Administrator, 
Read/Write (CA-RW) or State System Administrator (SSA) to download CSV files 
from the FSP DCR. 

 Refer to the FSP DCR User Manual at Chapter 12 “Data Extraction” for further 
instructions on downloading CSV files from the FSP DCR. 

The purpose of the PLD Templates is to organize a summary of a partnership’s information such 
that FSP DCR users can quickly identify missing or aberrant data values, which can then be 
corrected using the FSP DCR application. Data cannot be changed through the PLD Templates. 

 Refer to the FSP DCR User Manual at Chapter 11 “Data Correction” for further 
instructions on correcting data in the FSP DCR. 

Through PLD Templates, users upload the FSP DCR downloaded CSV data files, and the PLD 
Templates then provide a snapshot of each partnership up to the point in time when the CSV 
data files were last downloaded from the FSP DCR. No changes to data can be made directly 
through the PLD Templates. Any data added or corrected in the FSP DCR after the point of the 
CSV data download will not be displayed in the PLD Templates until a new CSV data file 
download is uploaded into PLD Templates. 

The Partner-Level Data Templates may be useful for the following activities. 

 PLD Template Uses: 
1. Reviewing individual partner history in the FSP program 
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2. Reviewing aberrant or questionable data for a partner as identified by data quality 
reports 

3. Identifying the assessment dates for data requiring correction for a partner 
4. Investigating and troubleshooting XML data submission errors for a partner’s data 
5. Cross-checking and spot-checking a county’s 3rd party application data compared to 

the FSP DCR data after XML uploads 
6. Creating additional queries and reports based on FSP DCR CSV data downloads 

utilizing the framework and data codes provided within the Partner-Level Data 
Templates tool 

System Requirements  
The FSP DCR reports require Microsoft Access 2010. However, a Microsoft Access 2007 version 
of the PLD Templates is available. (Microsoft Access 2003 and earlier does not support the 
required functionality for properly importing the DCR CSV files.) 

 Refer to the System Requirements for Microsoft Office 2010 for information about 
workstation requirements. 

Additionally, a workstation will require internet access in order to download data from the FSP 
DCR system and sufficient space to store and process these files (recommended 1 Gigabyte 
free). The workstation will also require a PDF viewing application such as the free Adobe® 
Reader software. 

Data Security 
The PLD Templates are empty (without data) when initially provided to Mental Health 
Directors, and authorized data download files from the FSP DCR must be used to populate the 
PLD templates. The FSP DCR is equipped with data security such that only authorized users can 
view or download CSV files of information for a partnership. PLD Templates are intended to be 
used with the data downloads for authorized FSP DCR users only. PLD Templates are encrypted 
with a default password. However, to secure information, it is recommended that users change 
the password for their personal use. 

 Refer to “Changing the Encrypted Password” later in this chapter for further 
information regarding resetting the PLD Templates password. 

Data reports exported or printed from the PLD Templates will contain personal identifying 
information and protected confidential health information and should be handled accordingly. 

http://office.microsoft.com/en-us/products/microsoft-office-2010-system-requirements-HA101810407.aspx.
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Note:   Data downloaded from the FSP DCR application as well as any reports 
generated from this data contain Protected Health Information (PHI), which 
must be protected with administrative, technical and physical safeguards as 
required by law pursuant to the Health Insurance Portability and Accountability 
Act of 1996 (HIPAA) Security Rule (45 CFR Part 160 and Part 164, Subparts A and 
E), the Health Information Technology for Economic and Clinical Health Act 
(HITECH Act), the California Security Breach Information Act (SB-1386,) and other 
state and federal law. Unauthorized use or disclosure is prohibited. It is the 
responsibility of the user of the PLD Templates to ensure the confidentiality of 
the PHI of partners in accordance with the aforementioned laws and the user’s 
organization's information security policies and procedures. 

Note Regarding Support 
The PLD Templates are offered as an unsupported tool to assist users to manage the FSP DCR 
data. The PLD Templates were constructed using standard Microsoft Access. Users do not need 
to be familiar with Microsoft Access in order to utilize the PLD Templates.  

Further, the PLD templates were built without the use of any peripheral procedures developed 
in Visual Basic. Therefore, users familiar with Microsoft Access alone should be able to support, 
augment or adjust the PLD Templates if desired.  

Note:   Always make a copy of the empty PLD Templates as a backup before adding data 
or making any changes to the templates. 

The Front Page  
When the PLD Templates file is first opened, a front page is displayed. From the front page, 
there are two main templates which can be accessed through the PLD Templates. 

 The Two PLD Templates: 
1. Browse Partner Data (BPD) Template 
2. Run Partner Report (RPR) Template 

As seen in Figure 1.1, the BPD template can be accessed by selecting one of the four buttons in 
the far left-hand box, and the RPR template can be accessed by selecting one of the two 
buttons in the center box of the front page. Instructions for importing new data downloads 
from DCR CSV files are available in the far right-hand box of the front page. 

 Refer to Chapter 2 “Importing New Data” for further information regarding the 
importing new data instructions. 
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Figure 1.1:  The Front Page 

 

Overview of PLD Templates 
The PLD Templates display partnership data as reported to the FSP DCR organized into 12 
sections. The main section of “Partner Information” contains the current or final status of the 
partnership, and the other 11 sections contain the history of changes reported throughout the 
partnership. The section organization is listed below. 

 PLD Template Sections: 
1. Partnership Information – The current status of partnership and administrative 

information for the partnership 
2. 3Ms – A history of the number of 3Ms completed, the count of days in the 

partnership when the assessment was performed and the quarter to which it applies 
3. Administrative Changes – A list of administrative changes reported for the 

partnership, including assessment date and dates of change 
4. D1: Residential – Days at each residential setting as report with two sub-sections: 

o 12 Months Before FSP 
o During FSP 

5. D2: Education – Education history, 3M assessments and key events: 
o 12 Months Before FSP 
o During FSP 

6. D3: Employment – Employment history and key events: 
o 12 Months Before FSP 
o During FSP 

7. D4: Financial – Financial support history and 3M assessments: 
o 12 Months Before FSP 
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o During FSP 
8. D5: Legal – Legal issues history, 3M assessments and key events: 

o 12 Months Before FSP 
o During FSP 

9. D6: Emergency – Emergency interventions history and key events: 
o 12 Months Before FSP 
o During FSP 

10. D7-D8: Health & Substance Abuse – Health and substance abuse history and 3M 
assessments: 

o 12 Months Before FSP 
o During FSP 

11. D9: Activities of Daily Living (ADL) – ADL 3M assessments: 
o During FSP 

12. D10: Instrumental Activities of Daily Living (IADL) – IADL 3M assessments: 
o During FSP 

 
 Refer to the Full Service Partnership (FSP) Data Collection and Reporting (DCR) Data 

Dictionary document to review the Complete Variable Index (CVI) for each domain. 

Overview of the Browse Partner Data (BPD) Template 
The BPD template allows users to browse through the data of all of the partnerships. As seen in 
Figure 1.2, the BPD template displays an overview of the partnership information and a tab for 
each domain. 

  

http://www.dmh.ca.gov/POQI/docs/FSP_Data_Dictionary_October_2011.pdf
http://www.dmh.ca.gov/POQI/docs/FSP_Data_Dictionary_October_2011.pdf
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Figure 1.2:  The Browse Partner Data (BPD) Template 

 
By selecting each tab, users can review all of the FSP data reported for a partnership. 
Alternatively, users can select one tab of domain information, such as the D5: Legal domain for 
example, and then scroll through each partnership to browse just the data reported for that 
domain (e.g., legal) for each partnership.  

There are four buttons on the front page to access the BPD Template, which will help filter the 
number of partnerships displayed in the template. 

 The Four Ways to Access the BPD Template: 
1. Browse All Partners displays all partnerships downloaded from the FSP DCR. 
2. Find All Partners’ Data for a Coordinator displays all partnerships for a coordinator 

based on entering any part of the coordinator ID. 
3. Find a Partner’s Data – Search by ID displays the partnership data for a partner by 

CSI number or by FSP DCR Global ID. 
4. Find a Partner’s Data – Search by Name displays the partnership data for a partner 

based on entering any part of a partner’s name. 
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Overview of the Run Partner Report (RPR) Template 
The RPR template produces a printable report of one partnership’s data. As seen in Figure 1.3, 
the RPR template displays an overview of the partnership information in a multi-page report 
which is separated into sections by domain. 

Figure 1.3:  The Run Partner Report (RPR) Template 

 

Users can choose to view the partnership report online, print the report or save a PDF of the 
report on their secure drive/network. A user must have available either the CSI number or the 
Global ID of a partnership in order to access this template. There are two buttons to launch the 
RPR template. 

 The Two Ways to Access the RPR Template: 
1. View Partner Report – Search by ID:  Displays a printable partnership data report for 

a partnership by CSI number or by FSP DCR Global ID. 
2. Export PDF Report – Search by ID:  Saves a partnership data report as a PDF at a 

chosen location on the user’s drive/network. 
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Managing Open Templates in Microsoft Access 
The PLD Templates application will organize all of your open templates into tabs across the top 
of the page. As seen in Figure 1.4, a tab will be generated each time a user selects a button 
from the front page (except for the Export PDF Report, which saves a file). In Figure 1.4, a tab is 
open for the front page and each of the buttons on the page (except for the Export PDF Report 
button). Re-selecting the button on the front page while the corresponding tab is still open will 
relocate the user to that tab. To run the template again to select a different set of partnerships, 
first close the open template and then select the appropriate button to rerun the template with 
new search criteria. 

 
Figure 1.4:  Managing Open Templates 

 

Any open template can be closed using the X in the upper right-hand corner of the open 
template. No information will be lost from the PLD Templates by closing and opening the BPD 
or RPR templates. If the FrontPage is accidentally closed, then close and re-open the application 
to access the front page once again. 

Changing the Encrypted Password 
The PLD templates come empty of data and equipped with an encrypted password, which will 
be provided to each Mental Health Director. The encrypted password can be changed with the 
following instructions. It is most efficient to decrypt and re-encrypt the PLD templates when 
they are clear of data. 
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To Change the Encrypted Password 

1. The PLD templates must first be opened in “Exclusive” mode for the encryption 
and decryption. Launch Microsoft Office from your computer’s program Menus. 
Then, as seen in Figure 1.5, select File > Open to launch a file browser screen. 
 

2. As seen in Figure 1.5, browse to the PLD Templates file and click once to 
highlight the file. Select the down arrow      to the right of the open button and 
choose Open Exclusive. 

 
Figure 1.5:  Opening the PLD templates in “Exclusive” Mode 

 
 

3. If the PLD templates have been populated with data, then first clear the data. 
(This will expedite the decryption and encryption process.)  Otherwise, skip to 
step 5. From the front page of the PLD Templates, click on the Instructions 
button in the “Import New Data Download from DCR CSV Files” box. As seen in 
Figure 1.6, click the [>> Clear Data <<] button to clear all data from the PLD 
templates. 
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Figure 1.6:  Clearing the Data from the PLD Templates 

 
 

4. After clearing the data, compact and repair the PLD templates to expedite the 
encryption process. As seen in Figure 1.7, select the File menu and select the 
Compact and Repair Database button. 
 

Figure 1.7:  Compact and Repair PLD templates 

 
 



Chapter 1:  Introduction 
 

FSP Partner-Level Data Templates User Manual Page 13 
 

5. Decrypt the PLD templates to remove the current encryption password. As seen 
in Figure 1.8, select the File menu and select the Decrypt Database button. 
Enter the current password when prompted. 
 

Figure 1.8:  Decrypt PLD templates 

 
 

6. Re-encrypt the PLD templates with the new encryption password. As seen in 
Figure 1.9, select the File menu and select the Encrypt Database button. Enter 
and verify the new password when prompted. 
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Figure 1.9:  Encrypt the PLD templates 

 
 

7. The PLD templates are now encrypted with the new password. Close the PLD 
templates from “Exclusive” mode and open the PLD templates normally by 
double clicking on the file. Enter the new password to access the PLD templates. 

Compacting and Repairing the PLD Templates 
To maintain optimal performance of your PLD Templates, the file must be compacted and 
repaired on occasion. We recommend that the PLD Templates be compacted and repaired each 
time before an updated set of data is imported into the PLD Templates, and the step to 
compact and repair exists in the appropriate location in the instructions for importing data. In 
addition, however, the PLD Templates may need to be compacted and repaired after some use 
to view the imported data. Compacting and repairing the PLD Templates while they contain 
data will be slower than compacting and repairing the empty database during the data import 
procedure. Depending on the level of use of the PLD Templates, we recommend that the PLD 
Templates are compacted and repaired on a regular schedule (e.g., once a week).   

To Compact and Repair the PLD Templates 

1. As seen in Figure 1.10, with the PLD Templates open in Microsoft Access, select 
the File menu. 

2. As seen in Figure 1.10, select the Compact and Repair Database button. 
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Note:   The compact and repair database procedure can be stopped by pressing CTRL + 
BREAK or ESC on your keyboard. 

Figure 1.10:  Compacting and Repairing the PLD Templates 
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Chapter 2: Importing New Data 
The PLD Templates come empty of data. It is recommended that users store an empty copy of 
the PLD Templates as a backup in the event that Microsoft Access file corruption issues arise 
while utilizing the PLD Templates. The PLD Templates are designed for use with the DCR CSV 
files, which can be downloaded from the online FSP DCR. Users must use the downloaded data 
files from the online FSP DCR application. 

 Refer to the FSP DCR User Manual at Chapter 12 “Data Extraction” for further 
instructions on downloading CSV files from the FSP DCR. 

The PLD Templates are designed to work with one entire set of the four downloaded FSP DCR 
CSV files (PAF Residence, PAF Non-Residence, KET and 3M) at a time. Therefore, when a new 
updated set of files is downloaded for use with the templates, the old data must be cleared 
from the database. 

Importing Data Files 
Before importing new data for the first time, make a copy of the empty PLD Templates to store 
as a backup. 

To Import Data to the PLD Templates 

1. With the PLD Template open in Microsoft Access, as seen in Figure 2.1, select 
the Instructions button from the front page. 

Figure 2.1:  Accessing the Instructions for Importing New Data 
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2. Perform Step 1 from the instructions to clear the data from the database. By 
selecting the [>> Clear Data <<] button, a macro will run to clear all of the 
existing data in the database. If no data exists in the database, performing this 
step will not harm the PLD Templates. As seen in Figure 2.2, a pop-up message 
will alert you when the process is complete. 

Note:   Existing data must be cleared before using the PLD Templates with new data 
downloads. If it is desired to use the PLD Templates with both the historic and 
current sets of downloaded DCR CSV files, then a copy of the PLD Templates file 
can be made before clearing the historic data such that one file will contain the 
historic data and the other will be cleared and used to import the current data. 

Figure 2.2:  Data Cleared Alert Message 

 
 

3. Perform Step 2 to compact and repair the empty PLD Templates. Microsoft 
Access may close the Instructions tab during the compact and repair process. 
Simply re-open the tab by selecting the Instructions button on the front page 
and continue the data import process. 
 

4. Perform Step 3 to import the current data files of FSP DCR data. This step will be 
repeated until all four CSV files have been uploaded into the appropriate tables 
in the PLD Templates: 
 

• Import the PAF Residential File into the [DCR_PAFRes] table 
• Import the PAF Non-residential file into the [DCR_PAFnonRes] table 
• Import the KET file into the [DCR_KETs] table 
• Import the 3M file into the [DCR_3M] table 

Note:   The tables listed above will appear at the bottom of the drop-down list. Be sure 
to carefully read the table names in the drop-down list to ensure the correct 
table is selected for the import file. An error message will prevent you from 
importing the data into the wrong table. 
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As seen in Figure 2.3, after each file is imported, a pop-up screen will alert you 
that the process is complete. The pop-up screen will also alert you if any errors 
were present in the import. Any errors from the data import will be saved in a 
table noted on the pop-up screen. 

Note:   The “CreatedDate” from the 3M CSV file may be corrupt in the FSP DCR data 
downloaded file. Although all of the other fields will import correctly, the 
“CreatedDate” field may not import with each 3M record. This is okay and it will 
not affect the use of the PLD Templates.  If this occurs, the pop-up screen will 
alert you that there were errors on import, and the table of errors can be 
reviewed. A review of the table of errors will show that the only field with error 
was the “CreatedDate” field because of a “Type Conversion Failure”. 

 
 Refer to the “Reviewing Data Import Errors” section later in this chapter for further 

instructions on reviewing data import errors. 
 

Figure 2.3:  All Data Imported without Errors Message 

 
 

 
5. Perform Step 4 by selecting the [>> Run Update <<] button. This will run a 

macro which will make the data available to the templates.  
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Note:   The new data will not be available for viewing through the PLD Templates until 
the [>> Run Update <<] macro is run. The macro generates the necessary 
temporary tables based on a series of Microsoft Access queries.  

Reviewing Data Import Errors 
Errors that occur during data import can be reviewed in the Microsoft Access table generated 
from the import process. 

To Review Data Import Errors 

1. As seen in Figure 2.4, with the PLD Template open in Microsoft Access, select 
the [>>] button on the top of the bar labeled Navigation Pane. 
 

Figure 2.4:  Expanding the Navigation Pane 

 
 

2. As seen in Figure 2.5, the Navigation Pane will expand to show the tables, 
queries, forms, reports and macros which support the PLD Templates. Scroll to 
the top of the Tables section and review the table names until you reach the 
table containing the import errors as noted by the complete file import pop-up 
screen at the end of the file import process.  

Note:   A table with import errors will only be present if one was created during the 
import text file process.  
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Figure 2.5:  Locating the Import Errors Table 

 
 

3. Double click on the table with errors to open a view of the table. 
 

4. As seen in Figure 2.6, the table will display the errors from the import. To 
quickly view all of the fields with error, select the down arrow        in the Field 
column. This will bring a pop-up window allowing you to filter the table based 
on all of the fields which had errors. In this example, the only field with import 
errors was the “CreatedDate” field. 

 
Figure 2.6:  Reviewing the Import Errors Table 
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5. After reviewing the errors, close and delete the error table to keep the database 
clear of extraneous data. As seen in Figure 2.7, right click on the table with 
import errors and select the Delete option. Click okay to confirm the deletion. 

Figure 2.7:  Deleting the Import Errors Table 
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Chapter 3:  The Browse Partner Data (BPD) Template 
The BPD template includes several options to browse partners’ data, which can be accessed 
through the four buttons in the “Browse Partner Data” section of the front page as seen in 
Figure 3.1. You can browse through all partners’ partnership data or search by partner ID, 
partner name or coordinator ID.   
 

Figure 3.1: The Buttons to Access the BPD Template 

 
 

Selecting any of the four buttons and entering appropriate criteria when required will display 
the BPD template. At the top of the BPD template, the “Data Displayed Through:” date signifies 
the last time the data in the PLD templates was updated from FSP DCR data file downloads. 
Under the subheading of “Partner Information”, the first partnership’s partner information will 
be displayed.  

There may be many partnerships available to browse. The total amount of partnerships and the 
current order of the partnership being viewed are displayed at the bottom left-hand corner of 
the report as the Record navigation box. As seen below in the example in Figure 3.2, the first of 
5,753 total partnerships is displayed in this example. 
 

Figure 3.2: The Record Navigation Box 

 
 

You can navigate to the next or previous partnership by clicking on the arrows to the left and 
right of the Record navigation box. Additionally, you can locate a partnership in a specific order 
by clicking on the Record navigation box and manually typing in a number within the range of 
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the available partnership count and pressing Enter. The form will jump to the partnership 
associated with that order number. This may be useful when the partnerships are sorted in the 
form by a specific order. By default, the partnerships are sorted by partnership status and 
partnership date, such that the active partnerships with the most recent partnership dates 
appear first. However, the partnerships can be sorted by other fields in the template. 

To Sort the Partnership Order in the BPD Template 

1. Place your cursor in the field in the “Partner Information” section of the BPD 
template which you would like to use to sort the partnerships (e.g., Age Group). 
 

2. As seen in Figure 3.3, select the Home menu and by selecting either the 
Ascending or Descending button to sort the partnerships by the previously 
selected field. 

 

Figure 3.3: The Sorting Buttons 

 
 

In a similar manner, you can jump to a specific partnership in the BPD Template through the 
Find option. 

To Jump to a Partner in the BPD Template 

1. Place your cursor in the field in the “Partner Information” section of the BPD 
template which you would like to use to find a partnership (e.g., Partner Name). 
 

2. As seen in Figure 3.4, select the Home menu and then select the Find button. 
 

Figure 3.4: The Find Button 
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3. As seen in Figure 3.5, enter the criteria for the search. In this example, we are 
searching the partner name field to find a specific partner by name. 

 

Figure 3.5: Entering Search Criteria to Find a Partner 

 
 

4. As seen in Figure 3.5, the Find box will remain open, and you can select the Find 
Next button to jump to the next partnership with matching search criteria. 

Note:   Selecting to search information under the “Domain Data For” sections in the 
lower half of the BPD template will only search for data within the partnership 
which is currently being displayed. The search will not bring up other 
partnership’s matching data. 

Under the “Domain Data For” subheading, there are tabs for the partnership’s information such 
as their legal, financial and employment data. All domain options are displayed in Figure 3.6. 
Data associated with a tab will be displayed by clicking on the tab. If the data for the tab is 
longer than the remaining vertical space in the application screen, then a vertical scroll bar will 
appear to allow scrolling within the table embedded in the tab.   

 

Figure 3.6:  Available Domain Data Tabs in the BPD Template 

 
 

When a tab is selected, you can change records to the next partnership and the same tab of 
data for the new partnership will be displayed. In this way, you can quickly review and compare 
data for one domain, for example financial data, as you move through partnership records. 

The four buttons on the front page to access the BPD template will apply a different filter on 
the number of partnerships displayed, and the criteria for the filters are displayed in the 
remaining sections of this chapter. 
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Browse All Partner’s Data Button 
The Browse All Partner’s Data button applies no filter to the BPD template such that all 
available partnerships are displayed. To browse data for all partnerships, click on the Browse 
All Partners’ Data button from the “Browse Partner Data” box on the front page. As seen in 
Figure 3.7, the Browse All Partner’s Data button will display the BPD Template in a tab titled 
“Partner_Info”.  

Figure 3.7: The Browse All Partners’ Data Tab 

 

Find All Partner’s Data for a Coordinator Button 
The Find All Partner’s Data for a Coordinator will apply a filter to the BPD template based on 
matching the criteria entered with a coordinator ID. As seen in Figure 3.8, selecting this button 
will bring up the “Enter Parameter Value” pop-up window. Typing in any portion of a 
coordinator ID in the box will apply the filter to the BPD template. The BPD template will then 
display only those partnerships with associated coordinator IDs containing the entered text as 
any consecutive part of the coordinator ID. For example, entering “Smith” in the “Enter 
Parameter Value” pop-up window will display partnerships for all coordinator IDs with any 
portion of “Smith” as part of the ID. 
 

Figure 3.8: The Pop-Up Window for Search Criteria of a Coordinator ID 

 
 

As seen in Figure 3.9, the BPD template will open in a new tab titled 
“Partner_Info_SearchbyCoor” with partnership records that are exclusive to the coordinator ID 
search performed. The number of partnerships available can be seen in the Record box in the 
lower left-hand corner of the screen.   
 

Figure 3.9: The Find All Partner’s Data for a Coordinator Tab 
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Find a Partner’s Data – Search by ID Button 
The Find a Partner’s Data – Search by ID button will apply a filter to the BPD template based on 
matching the criteria entered with a partner ID. There are two options for entering partner IDs. 
You can enter a CSI number in the first pop-up window or enter a Global ID in the second 
window. 

To search for a specific partnership by partner ID number, click on the Find a Partner’s Data – 
Search ID button under the “Browse Partner Data” heading. As seen in Figure 3.10, the first 
pop-up window that appears will allow you to enter search criteria of CSI number. If known, 
enter the CSI number and press OK. If you would prefer to search by Global ID, enter nothing in 
this first window and click OK to skip the search by CSI number.  
 

Figure 3.10: The Pop-Up Window for Search Criteria of a CSI Number 

   
 

Note:   You can use CTRL + V to paste search criteria values into the “Enter Parameter 
Value” pop-up windows.  

As seen in Figure 3.11, the second pop-up window that appears will allow you to enter search 
criteria of Global ID. If a CSI Number was already entered in the previous pop-up window, then 
click OK to skip the search by Global ID. If the CSI Number was not entered, then enter a Global 
ID for a partnership and press OK to continue. 
  

Figure 3.11:  The Pop-Up Window for Search Criteria of a Global ID 
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As seen in Figure 3.12, the BPD template will open in a new tab titled 
“Partner_Info_SearchbyID” with the partnership information for the partnership matching the 
partner ID entered into the search box. The number of partnerships for partners with matching 
IDs is displayed in the Record box in the lower left-hand corner of the screen.   
 

Figure 3.12: The Find a Partner’s Data – Search by ID Tab 

 
 

Find a Partner’s Data – Search by Name Button 
The Find a Partner’s Data – Search by Name will apply a filter to the BPD template based on 
matching the criteria entered with a partner’s name.  

As seen in Figure 3.13, selecting this button will bring up the “Enter Parameter Value” pop-up 
window. Typing in any portion of a partner’s name in the box will apply the filter to the BPD 
template. The BPD template will then display only those partnerships which contain the 
entered text as any consecutive part of the partner name. For example, entering “Martin” in 
the “Enter Parameter Value” pop-up window will display partnership data for all partnerships 
with any portion of “Martin” as either their first or last name. The standard FSP DCR format for 
the name field is “Last, First”.  Therefore, you can conduct a search for a partnership using the 
full name with that format. As seen in Figure 3.13, for example John Doe would be found using 
“Doe, John”. 
 

Figure 3.13:  The Pop-Up Window for Search Criteria of a Partner’s Name 

 
 

As seen in Figure 3.14, the BPD template will open in a new tab titled 
“Partner_Info_SearchbyName” with partnerships matching the search criteria displayed. The 
number of partnerships matching the search can be seen in the Record box in the lower left-
hand corner of the screen.   

Figure 3.14: The Find All Partner’s Data for a Coordinator Tab 
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Chapter 4:  The Run Partner Report (RPR) Template 
The RPR template includes two options to generate a partnership report, which can be 
accessed through the two buttons in the “Run Partner Report” section of the front page as seen 
in Figure 4.1. The RPR template can be viewed in Microsoft Access as an Access report or it can 
be exported as a PDF file.  
 

Figure 4.1:  The Buttons to Access the RPR Template 

 
 

The View Partner Report – Search by ID Button 
The View Partner Report – Search by ID button will display a report within Microsoft Access, 
which can be viewed electronically or printed from Microsoft Access. A report for a partnership 
is displayed based on matching the criteria entered for a partner ID. There are two options for 
entering partner IDs. You can enter a CSI number in the first pop-up window or enter a Global 
ID in the second pop-up window. 

To display a report for a specific partnership, click on the View Partner Report – Search by ID 
button under the “Run Partner Report” heading. As seen in Figure 4.2, the first pop-up window 
which appears will allow you to enter search criteria of CSI number. If known, enter the CSI 
number and press OK. If you would prefer to search by Global ID, click OK to skip the search by 
CSI number.  
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Figure 4.2:  The Pop-Up Window for Search Criteria of a CSI Number 

 

Note:   You can use CTRL + V to paste search criteria into the “Enter Parameter Value” 
pop-up windows.  

As seen in Figure 4.3, the second pop-up window which appears will allow you to enter search 
criteria of Global ID. If a CSI Number was already entered in the previous pop-up window, then 
click OK to skip the search by Global ID. If the CSI Number was not entered, then enter a Global 
ID for a partnership and press OK to continue.  

 

Figure 4.3:  The Pop-Up Window for Search Criteria of a Global ID 

 

Note:   The RPR template can only be run using a partner ID. If a partner ID is unknown, 
but a partner name is known, then the CSI number and/or Global ID can be 
identified by using the BPD template and searching for a partnership using the 
partner’s name. Then the IDs from the BPD template can be copied and pasted 
as search criteria for the RPR template.  

As seen in Figure 4.4, the RPR report will open as a new tab titled “Partner_Level_Report”. 

 

Figure 4.4: The View Partner Report- Search by ID Tab 

 
 

As seen in Figure 4.5, the report will open in print preview mode.  At the top of the RPR 
template, the “Data Displayed Through:” date signifies the last time the data in the PLD 
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templates was updated from FSP DCR data file downloads.  The bottom right-hand corner of 
the report will display the page number. 

 
Figure 4.5: The View Partner Report – Search by ID Report 

 
 

As seen in Figure 4.6, the Page selector in the lower left-hand corner will allow you to scroll or 
jump to any page in the report. 

 

Figure 4.6:  The Page Selector 

 
 

As seen in Figure 4.7, a zoom slide-bar in the lower right-hand corner allows you to quickly 
enlarge or shrink the view of the report on the screen. 

 

Figure 4.7:  Zoom Slide-bar 

 
 

As seen in Figure 4.8, The Print Preview ribbon heading has print options. Clicking Print will 
print the partnership report. You can also zoom in or out and view the report by more than one 
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page in the “Zoom” section of the ribbon. The Close Print Preview option will exit the partner 
level report and return you to the front page. 

 

Figure 4.8:  The Print Preview Ribbon 

 
 

Note:   The margins of the partner report are set for printing on standard printers. 
Adjusting the margins may affect the quality of the report. However, if the report 
prints extra blank pages on your printer, then slightly widening the margins may 
solve the issue. 

The Export PDF Report – Search by ID Button 
The Export PDF Report – Search by ID button will export a PDF file of a partnership report to a 
desired location on your network. There are two options for identifying the partnership for the 
report. You can enter a CSI number in the first pop-up window or enter a Global ID in the 
second pop-up window. 

To export a report for a specific partnership, click on the Export PDF Report – Search by ID 
button under the “Run Partner Report” heading. As seen in Figure 4.9, an “Output To” window 
will appear which is used to designate a location and file name for the report. The default name 
of the report, “Partner_Level_Report”, can be changed. Use the navigation pane on the left-
hand side of the window to select a folder to which the PDF report will be saved. Select the 
Autostart checkbox if you would like the report to be opened automatically when the export 
and save process is complete. Then click OK. Selecting Cancel will return you to the front page 
without exporting the report. 
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Figure 4.9:  The Output To Window  

 
 

As seen previously in Figure 4.2, the first pop-up window which appears will allow you to enter 
search criteria of CSI number. If known, enter the CSI number and press OK. If you would prefer 
to search by Global ID, enter nothing and click OK to skip the search by CSI number.  

As seen previously in Figure 4.3, the second pop-up window which appears will allow you to 
enter search criteria of Global ID. If a CSI Number was already entered in the previous pop-up 
window, then enter nothing and click OK to skip the search by Global ID. If the CSI Number was 
not entered, then enter a Global ID for a partnership and press OK to continue.  

After the partner ID search criteria are entered, the PDF file will be generated and the file will 
be saved in the selected location. If the Autostart checkbox was marked, a copy of the report 
will open in a PDF viewing application. 
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